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Section 1 - Présentation du produit

Introduction

Cet adaptateur mobile, compact et élégant se glisse facilement dans la poche•	
Prise en charge des réseaux HSDPA/UMTS/GPRS/GSM/EDGE•	
Transfert de données multimédia à liaison commutée (CSD) GSM•	
Plug-and-Play : Aucun CD-ROM requis•	
Le logiciel de connexion se lance rapidement et automatiquement•	
Le connecteur USB pratique ne requiert aucun câble supplémentaire•	
Compartiment pour le lecteur de carte MicroSD pour périphérique de stockage amovible en option•	
Envoyez des SMS groupés à 25 contacts simultanément•	
Conservez jusqu'à 1 000 SMS sortants (selon la capacité de la carte SIM)•	
Contrôle des appels entrants avec transfert, tonalité Occupé ou sonnerie continue•	

L'adaptateur USB HSDPA 3.5G permet aux utilisateurs équipés d'un ordinateur de se connecter à des réseaux haut 
débit mobiles (HSDPA/UMTS/GPRS/GSM/EDGE). Lorsque les utilisateurs sont connectés, ils peuvent transférer des 
données, diffuser du contenu multimédia et envoyer des SMS. L'adaptateur utilise une interface USB standard pour 
une installation rapide et simple.  

Caractéristiques



6Manuel d’utilisation du DWM-152 D-Link

Section 1 - Présentation du produit

Windows 2000/XP/VISTA ou Mac OS X 10.4.0•	 +
Pentium III ou version supérieure•	
RAM de 128 Mo ou version supérieure•	
50 Mo d'espace disque disponible•	
Internet Explorer v6.0•	 + / Firefox v1.5+ 
Ordinateur avec un port USB 2.0 disponible•	

Présentation du produit

Adaptateur USB HSDPA 3.5G DWM-152 D-Link

Configuration système requise

Contenu de la boîte
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Section 1 - Présentation du produit

Description du matériel

Port USB
Permet de connecter le DWM-152 à un 
ordinateur.

Indicateur d'état
Voyant multicolore indiquant 
l'état de la connexion.

Compartiment pour carte SIM
Compatible avec une carte SIM 
standard.

Compartiment pour carte MicroSD
Compatible avec une carte MicroSD 
(jusqu'à 8 Go).
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Section 1 - Présentation du produit

Couleur Service Clignote Reste allumé

Jaune Système –
Initialisation du périphérique 

/ pas de signal

Rouge Entretien de 
la carte SIM Recherche

Erreur  
(Pas de carte SIM / 
carte SIM invalide)

Vert WCDMA Enregistré Connecté

Bleue HSDPA – Connecté

Pourpre GPRS/
EDGE Enregistré Connecté

Informations sur le voyant
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Section 2 - Installation

Installation

Suivez la procédure suivante pour installer une carte SIM :

Retirez le couvercle de l'extrémité de l'adaptateur.1.	

Retirez le plateau de la carte SIM (illustration 1).2.	

Insérez la carte SIM, les contacts dorés pointant vers le bas 3.	
(illustration 2).

Replacez le plateau de la carte SIM dans l 'adaptateur 4.	
(illustration 3).

Connectez l 'adaptateur à un port USB de l 'ordinateur 5.	
(illustration 4).

Remarque : Pour retirer une carte SIM installée, retirez son plateau 
et soulevez-la légèrement.

Illustration 1

Illustration 2

Illustration 3

Illustration 4

Installation de la carte SIM




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Section 2 - Installation

Installation de la carte MicroSD

Suivez la procédure suivante pour installer une carte MicroSD :

Débranchez l'adaptateur USB DWM-152 de l'ordinateur.1.	

Soulevez légèrement le coin supérieur gauche du capot du 2.	
compartiment de la carte MicroSD (illustration A).

Insérez la carte MicroSD, les contacts dorés pointant vers la partie 3.	
supérieure de l'adaptateur (illustration B).

Fermez le couvercle du compartiment de la carte MicroSD 4.	
(illustration C).

Branchez le DWM-152 dans un port USB de votre ordinateur.5.	

L'ordinateur prendra peut-être un petit moment pour reconnaître 6.	
le périphérique.

Un nouveau disque amovible apparaît dans la liste de périphériques 7.	
de stockage de votre ordinateur.

Remarque : Pour retirer une carte MicroSD, débranchez le périphérique 
de l'ordinateur. Ouvrez le couvercle du compartiment de 
la carte et appuyez doucement sur cette dernière pour 
l'éjecter.

Illustration A

Illustration B

Illustration C

Le DWM-152 possède un compartiment permettant de lire les cartes MicroSD d'une capacité atteignant 
8 Go.
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Section 2 - Installation

Ouvrez 1.	 Poste de travail.
Double-cliquez sur le lecteur amovible étiqueté 2.	 ConnMgr.
Double-cliquez sur le fichier étiqueté 3.	 setup.exe pour démarrer 
l'installation.
Suivez les instructions étape par étape de l'Assistant 4.	
d'installation.
Le D-Link Mobile Connection Manager (Gestionnaire des 5.	
connexions mobiles D-Link) se lance automatiquement.

Installation du logiciel
Avant d'installer le logiciel, commencez par insérer une carte SIM dans l'adaptateur USB, puis connectez ce dernier 
dans un port USB de l'ordinateur.
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Section 3 - Fonctions de base

Fonctions de base
Présentation du logiciel

Une fois le programme installé, vous pouvez lancer l'application de modem USB DWM-152 en double-
cliquant sur son cône sur le Bureau ou via Démarrer > Programmes > D-Link > Modem USB 
D-Link.

Une fois lancée, l'icône D-Link Mobile Connection Manager (Gestionnaire des connexions mobiles D-Link) s'ouvre 
dans la zone de notification Windows. Elle comporte toutes les fonctions nécessaires pour gérer votre connexion 
sur un réseau de service mobile.
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Section 3 - Fonctions de base

Nouveau profil
Avant de commencer, si le fournisseur de services mobiles associé 
à votre carte SIM est répertorié dans la liste de profils prédéfinie, 
vous pouvez vous connecter directement au réseau souhaité. 

Vous pouvez également créer votre propre profil en procédant 
comme suit :

Cliquez sur le bouton 1.	 Profile (Profil).
Cliquez sur le bouton 2.	 New (Nouveau) pour activer l'assistant 
qui vous aidera à créer un nouveau profil.
Sélectionnez le type de profil : 3.	 Preconfigured Profile (Profil 
préconfiguré) ou User Defined Profile (Profil défini par 
l'utilisateur). Cliquez sur Next (Suivant) pour continuer.

Utilisation du profil par défaut (prédéfini)
Sélectionnez un Profile Name (Nom de profil) dans le menu 1.	
déroulant. La plupart des informations requises sont renseignées 
automatiquement dans les champs.
Si nécessaire, indiquez le Phone Number (Numéro de téléphone), 2.	
l'APN, le User Name (Nom d'utilisateur) et le Password (Mot 
de passe). 
Si nécessaire, cochez la case pour qu'il devienne le profil par 3.	
défaut.
Cliquez sur 4.	 Next (Suivant) pour continuer.
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Section 3 - Fonctions de base

Fin de connexion

Création d'une connexion
Le bouton de connexion/déconnexion devient noir lorsque vous êtes hors ligne. Vous pouvez cliquer 
sur le bouton Connect (Connexion) pour vous connecter au réseau avec le profil par défaut. Après 
vous être connecté, le bouton devient vert et porte une coche. Une fois connecté, vous pouvez utiliser 
le réseau de service mobile pour naviguer sur Internet, envoyer des courriers électroniques, envoyer 
des SMS et réaliser d'autres tâches en ligne.

Pour vous déconnecter, cliquez de nouveau sur le bouton ; il devient noir pour indiquer que vous êtes 
déconnecté et hors ligne.

Profil défini par l'utilisateur
Indiquez le Profile Name (Nom de profil), le Phone Number 1.	
(Numéro de téléphone), l'APN, le User Name (Nom 
d'utilisateur), le Password (Mot de passe) et l'Authorization 
Type (Type d'autorisation). 
Cliquez sur sur 2.	 Finish (Terminer) pour terminer.
Cliquez sur le bouton 3.	 Advanced (Avancé) pour afficher 
les détails de l'APN.
Mettez un APN en surbrillance, puis cliquez sur 4.	 OK.
Cliquez sur 5.	 Next (Suivant) pour continuer.

Connecter

Déconnecter
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Section 4 - Gestion des profils

Gestion des profils

Édition
Cliquez sur le bouton 1.	 Profile (Profil).
Sélectionnez un profil, puis cliquez sur le bouton 2.	 Edit (Édition).
Cliquez sur l'onglet approprié, puis saisissez les informations dans les champs.3.	
Cliquez sur le bouton 4.	 Advanced (Avancé) pour afficher une liste d'utilisateurs et leurs zones 
dans la fenêtre ci-dessous.
Cliquez sur 5.	 OK pour fermer la fenêtre APN.
Cliquez sur 6.	 OK pour fermer la fenêtre Edit Profile (Éditer le profil).

Remarque : Les profils ne peuvent qu'être édités lorsque vous êtes déconnecté.

Suppression d'un profil
Cliquez sur le bouton 1.	 Profile (Profil).
Sélectionnez un profil défini par l'utilisateur, puis cliquez sur le bouton 2.	 Delete (Supprimer).
Cliquez sur 3.	 Yes (Oui) pour confirmer la suppression.

Suppression de tous les profils
Cliquez sur le bouton 1.	 Profile (Profil).
Cliquez sur le bouton 2.	 Delete All (Supprimer tout).

Configuration du profil par défaut
Cliquez sur le bouton 1.	 Profile (Profil).
Mettez en surbrillance le profil à utiliser au démarrage du DWM-152.2.	
Cliquez sur 3.	 Set as Default (Définir par défaut) pour que le profil devienne le profil par 
défaut.

Réinitialisation des paramètres par défaut
Cliquez sur le bouton 1.	 Profile (Profil).
Cliquez sur 2.	 Set as Factory Default (Définir comme paramètre par défaut) pour réinitialiser 
le DWM-152 à ses paramètres d'usine.

Sous l'icône Profiles (Profils), les utilisateurs peuvent créer, modifier et supprimer les profils et les profils 
prédéfinis.

Profil
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Section 5 - Gestion des connexions

Gestion des connexions

Connexion actuelle

La fenêtre Connection Information (Informations sur la connexion) permet aux utilisateurs de gérer la connexion 
actuelle (si une connexion est établie), ainsi que son historique. Cliquez sur le bouton Connection Info (Infos sur la 
connexion) pour ouvrir la fenêtre Connection Information (Informations sur la connexion).

L'onglet Current Connection (Connexion actuelle) affiche les informations suivantes :

Profile Name (Nom du profil) - Affiche le profil actuel. Sélectionnez d'autres profils dans le menu 
déroulant.
Connection Type (Type de connexion) : Affiche la technologie de service mobile que le réseau de service 
utilise.
Connection Band (Bande de connexion) - Affiche la bande de la connexion actuelle.
Connected Time (Durée de la connexion) - Indique depuis combien de temps la session actuelle est active.
Volume - Affiche la quantité totale de données reçues (Rx) et transmises (Tx).
Speed (Vitesse) - Affiche les vitesses des données transmises et reçues.
Top Speed (Vitesse maximale) - Affiche les vitesses maximales de transmission et de réception atteintes.
Redial on Link Failure (Renuméroter en cas d'échec de la connexion) - Renumérotez si la connexion est perdue 
d'une manière quelconque. 

Remarque : Windows Vista requiert votre confirmation pour renuméroter 
en cas d'échec de connexion.

Connexion
Informations
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Section 5 - Gestion des connexions

Historique des connexions
L'onglet History Connection (Historique des connexions) affiche 
les informations suivantes :

Type - Type de connexions établies.
Profile (Profil) - Nom des profils utilisés.
Date & Time (Date et heure) - Date et heure de la connexion.
Duration (Durée) - Durée de la connexion en heures, minutes 
et secondes.
Volume - Quantité totale de données transmises et reçues.
Tx (Transmission) - Nombre total d'octets transmis.
Rx (Réception) - Nombre total d'octets reçus.

Procédez comme suit pour supprimer l 'historique des 
connexions :

Cliquez sur 1.	 Clear All Logs (Effacer tous les journaux) pour 
supprimer les journaux. 
Cliquez sur 2.	 Yes (Oui) pour confirmer.
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Section 6 - Gestion des utilisations

Gestion de l'utilisation

Usage

Des limites peuvent être définies quant à la durée d'une connexion. Ces limites peuvent être définies par l'utilisation 
(connexions 3G/GPRS) ou par la durée (connexions par numérotation).

Sélectionnez 1.	 Tools > Preference (Outils > Préférences).
Sélectionnez l'onglet 2.	 Usage (Utilisation).
Cochez la case 3.	 Limit by Data (Limiter par données).
Saisissez la valeur souhaitée entre 100 Mo et 10 000 Mo.4.	
Cliquez sur 5.	 Apply (Appliquer) pour enregistrer les paramètres. 
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Section 6 - Gestion des utilisations

Statistiques d'utilisation
Les statistiques d'utilisation et de durée peuvent s'afficher dans le menu d'utilisation.

Sélectionnez 1.	 View > Usage (Afficher > Utilisation).
Sélectionnez l'onglet 2.	 Current Month (Mois en cours) ou Previous Month (Mois 
précédent).

Procédez comme suit pour supprimer le journal du mois précédent :

Sélectionnez 1.	 View > Usage (Afficher > Utilisation).
Sélectionnez l'onglet 2.	 Previous Month (Mois précédent).
Cliquez sur 3.	 Clear all logs (Effacer tous les journaux).
Cliquez sur 4.	 Yes (Oui) pour confirmer.


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Section 7 - SMS

SMS
Le DWM-152 permet de réaliser toutes les fonctions de SMS d'un téléphone mobile, telles que l'envoi, la réception, 
la réponse, la transmission et la suppression.

SMS
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Section 7 - SMS

Nouveau message/réponse/transmission
Cliquez sur le bouton 1.	 SMS.
Cliquez sur 2.	 New (Nouveau), Reply (Répondre) ou Forward 
(Transmettre).
Saisissez le numéro de téléphone du destinataire ou cliquez sur 3.	
Contacts pour voir les contacts stockés sur la carte SIM.  Dans 
la fenêtre de contacts, cliquez sur la case en regard des noms 
des destinataires, puis cliquez sur Add (Ajouter) pour revenir à 
la fenêtre New SMS (Nouveau SMS).
Saisissez un message à envoyer.4.	
Cliquez sur 5.	 Send (Envoyer) pour envoyer le message.

Suppression d'un message

Enregistrement d'un émetteur aux contacts

Cliquez sur le bouton 1.	 SMS.
Sélectionnez les messages à supprimer. Pour supprimer tous les messages, cliquez sur 2.	 Select All (Sélectionner 
tout).
Cliquez sur 3.	 Delete (Supprimer) pour supprimer les messages sélectionnés.
Cliquez sur 4.	 Yes (Oui) pour confirmer.

Cliquez sur le bouton 1.	 SMS.
Sélectionnez un message.2.	
Faites un clic droit sur le message sélectionné, puis cliquez sur 3.	 Save to Contacts (Enregistrer dans les 
contacts).
Dans la fenêtre 4.	 Add Contact (Ajouter un contact), saisissez le nom du contact.
Cliquez sur 5.	 OK pour enregistrer le contact. 
Une fois le contact enregistré, une fenêtre de confirmation apparaît. Cliquez sur 6.	 OK pour la fermer.



22Manuel d’utilisation du DWM-152 D-Link

Section 7 - SMS

Paramètres des SMS
Ce menu vous permet de modifier le numéro du centre de service et sa période de validité, ainsi que d'indiquer 
d'enregistrer ou non les messages sortants dans le Mobile Connection Manager (Gestionnaire de connexions 
mobile) DWM-512.

Cliquez 1.	 Tools > SMS Settings (Outils > Paramètres des SMS).
Si nécessaire, saisissez le nouveau numéro du centre de service. 2.	
Sélectionnez la période de validité dans le menu déroulant.
Cochez la case pour enregistrer les messages sortants dans 3.	
l'application.
Cliquez sur 4.	 OKpour enregistrer les détails.





23Manuel d’utilisation du DWM-152 D-Link

Section 8 - Gestion des contacts

Gestion des contacts

Ajout de contacts

Suppression de contacts

Édition de contacts

Le gestionnaire de contacts du DWM-152 affiche tous les contacts sur la carte SIM. Vous pouvez ajouter, modifier, 
supprimer et importer des contacts.

Cliquez sur le bouton 1.	 Contacts.
Cliquez sur le bouton 2.	 Add (Ajouter).
Dans la fenêtre Add Contact (Ajouter un contact), saisissez le nom et le numéro de 3.	
téléphone du contact.
Cliquez sur 4.	 OKpour ajouter le contact.

Cliquez sur le bouton 1.	 Contacts.
Sélectionnez le contact à modifier.2.	
Cliquez sur le bouton 3.	 Edit (Édition).
Modifiez les données des contacts.4.	
Cliquez sur 5.	 OKpour enregistrer les modifications.

Cliquez sur le bouton 1.	 Contacts.
Sélectionnez le contact à supprimer. Pour supprimer tous les contacts, cliquez sur 2.	 Select All (Sélectionner 
tout).
Cliquez sur le bouton 3.	 Delete (Supprimer).
Cliquez sur 4.	 Yes (Oui) pour confirmer la suppression.

Contacts
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Section 8 - Gestion des contacts

Importation de vCards dans les contacts

Exportation de contacts dans les vCards
Cliquez sur le bouton 1.	 Contacts.
Cliquez sur le bouton 2.	 Export (Exporter).
Sélectionnez la destination où enregistrer la ou les vCards.3.	
Cliquez sur 4.	 OK pour exporter la ou les cartes.
Après l'exportation, un message apparaît. Cliquez sur 5.	 OK pour fermer.

Cliquez sur le bouton 1.	 Contacts.
Cliquez sur le bouton 2.	 Import (Importer).
Sélectionnez la source de la ou des vCards.3.	
Cliquez sur 4.	 Open (Ouvrir) pour importer la ou les cartes.
Après l'importation, un message affiche les informations d'importation. Cliquez sur 5.	 OK pour fermer.
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Section 9 - Gestion des cartes SIM

Gestion de la carte SIM

Informations sur la carte SIM
Pour consulter les détails concernant l'IMEI, le numéro de téléphone, l'utilisation des contacts et l'utilisation des 
SMS, présents sur la carte SIM, cliquez sur 
Support > About D-Link Mobile Connection Manager (Assistance > À propos du gestionnaire des connexions 
mobiles D-Link).

La gestion de la carte SIM inclut certaines fonctions, notamment l'activation/désactivation d'un code PIN, la 
modification des codes PIN1/PIN2, le contrôle des informations de la carte SIM, le réglage du numéro de téléphone, 
l'affichage de l'utilisation des contacts ainsi que l'affichage de l'utilisation des SMS.


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Section 9 - Gestion des cartes SIM

Activation ou désactivation d'un code PIN
Activer un code PIN
Pour éviter toute utilisation non autorisée de la carte SIM, un code PIN peut être 
activé. 

Sélectionnez 1.	 Tools > Enable/Disable PIN code > Enabled (Outils > Activer/
Désactiver le code PIN > Activé).
Saisissez le code PIN à activer.2.	
Cliquez sur 3.	 OK pour activer la protection par code PIN.

Si un code PIN a été activé, le système vous demande toujours de le saisir avant 
d'accéder au logiciel D-Link Mobile Connection Manager (Gestionnaire des 
connexions mobiles D-Link).

Désactiver
Si un code PIN n'est plus requis, vous pouvez le désactiver en procédant comme 
suit. 

Cliquez sur 1.	 Tools > Enable/Disable PIN code > Disabled (Outils > Activer/
Désactiver le code PIN > Désactivé).
Saisissez le code PIN correct.2.	
Cliquez sur 3.	 OK pour désactiver le code PIN.

Remarque : Le code PIN est fourni par votre fournisseur de service réseau.
Attention : Le code PIN doit être saisi correctement en trois essais. Sinon, la 
carte SIM sera bloquée.


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Section 9 - Gestion des cartes SIM

Modification d'un code PIN
Les cartes SIM contiennent souvent deux codes PIN que vous pouvez 
modifier.

Cliquez sur 1.	 Tools (Outils) > Change PIN Code (Changer de code PIN) > 
PIN1 ou PIN2.
Saisissez les données dans les champs suivants : Current PIN Code (Code 2.	
PIN actuel), Enter New PIN Code (Saisir un nouveau code PIN) et Confirm 
New PIN Code (Confirmer le nouveau code PIN).
Cliquez sur 3.	 OK pour modifier.
Une fenêtre de confirmation apparaît ensuite. Cliquez sur 4.	 OK pour fermer la 
fenêtre.

Attention : Le code PIN doit être saisi correctement en trois essais. Sinon, la 
carte SIM sera bloquée.

Remarque : Les codes PIN ne peuvent pas être modifiés alors que le DWM-152 
est connecté à un réseau mobile.

Déblocage d'un code PIN
Si le code PIN a été saisi incorrectement trois fois de suite et que la carte SIM s'est bloquée, procédez comme suit 
pour la débloquer :

Si un code PIN est bloqué, la fenêtre de déblocable apparaît.1.	
Saisissez le code PUK. Saisissez le nouveau code PIN, puis confirmez-le.2.	
Cliquez sur 3.	 OK pour confirmer le nouveau code PIN.

Remarque : Le code PUK est fourni par votre fournisseur de service mobile.


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Section 10 - Paramètres des profils

Paramètres de bande
Le DWM-152 prend en charge deux options de sélection de bande :

Automatic (Automatique) - Le DWM-152 sélectionne automatiquement 
la bande en fonction des réseaux disponibles dans la zone actuelle, 
ainsi que ceux qu'il prend en charge.

3G Only (3G uniquement) - Limite l'utilisation du DWM-152 au service 
3G sur les bandes WCDMA 850/1900/2100.

2G Only (2G uniquement) - Limite l'utilisation du DWM-152 au service 
2G sur les bandes GPRS 850/900/1800/1900.

Remarque : Si vous configurez accidentellement les mauvais paramètres, 
allez dans Tools > Reset Settings to Default Value (Outils > Réinitialiser 
les paramètres par défaut).
 
Pour définir les paramètres de bande, procédez comme suit :

Cliquez sur le bouton 1.	 Profile (Profil).
Sélectionnez l'onglet 2.	 Band (Bande).
Sélectionnez Automatic (Automatique), 3G only (3G uniquement) ou 2G 3.	
only (2G uniquement).
Cliquez sur 4.	 Apply (Appliquer) puis OK.

Paramètres des profils
La page Profile Settings (Paramètres des profils) vous permet de modifier manuellement vos paramètres Band 
(Bande) et Network (Réseau) au cas où votre DWM-152 ne parviendrait pas à se connecter automatiquement à 
votre fournisseur réseau.
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Section 10 - Paramètres des profils

L'emplacement actuel du DWM-152 peut être couvert par plusieurs 
réseaux. Le DWM-152 prend en charge deux options de sélection 
des réseaux :

Automatic (Automatique) - Par défaut, le DWM-152 sélectionne 
automatiquement le réseau en fonction du compte utilisateur 
et de la disponibilité du réseau.

Manual (Manuel) - Les utilisateurs peuvent aussi utiliser le 
DWM-152 pour obtenir la liste des réseaux, puis sélectionner 
un réseau disponible.

Pour définir le réseau manuellement, procédez comme suit :

Cliquez sur le bouton 1.	 Profile (Profil).
Sélectionnez l'onglet 2.	 Network Selection (Sélection du 
réseau).
Sélectionnez 3.	 Manual (Manuel).
Cliquez sur 4.	 Search (Rechercher) pour voir tous les réseaux 
disponibles.
Sélectionnez un opérateur du réseau et cliquez sur 5.	 Apply 
(Appliquer).
Cliquez sur 6.	 OK pour terminer.

Remarque : Lorsque la bande est réglée sur 3G Only (3G 
uniquement), la sélection manuelle ne fait qu'apparaître les réseaux 
3G.

Sélection d'un réseau
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Sélectionnez 1.	 Tools > Call Setting (Outils > Paramètre d'appel).
Vous pouvez choisir parmi les options suivantes :2.	

None (Aucune) - Pas de réponse.

Send Busy Tone - (Envoyer une tonalité Occupé)L'appelant entend 
une tonalité Occupé ou est transféré sur la messagerie vocale.

Call Forward (Transmission d'appel) - L'appel entrant est redirigé vers 
le numéro de téléphone saisi dans la zone de texte Telephone Number 
(Numéro de téléphone).

Remarque : La demande de paramètres d'appel peut échouer si le réseau 
est occupé ; dans ce cas, veuillez réessayer ultérieurement.

Paramètres d'appel

Appels manqués
Sélectionnez 1.	 View > Missed Calls (Afficher > Appels manqués).
Si le paramètre d'appel est None (Aucune) ou Send Busy Tone (Envoyer 2.	
une tonalité Occupé), le PA D-Link Mobile Connection Manager 
(Gestionnaire des connexions mobiles D-Link) enregistre l'appel entrant 
dans la liste des appels manqués.




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Options de démarrage

Informations sur la version

Les utilisateurs peuvent indiquer comment l'application doit démarrer.

1. Cliquez sur Tools > Preferences > Startup (Outils > Préférences > Démarrer).
2. Cochez la case en regard des options souhaitées.

	Always ask before closing a connection (Toujours demander avant de •	
déconnecter).
	Always ask before exiting application (Toujours demander avant de •	
quitter l'application).
	Enable Quick Start (Activer la configuration rapide) (ce mode exécute •	
un programme en arrière-plan pour aider à lancer D-Link Mobile 
Connection Manager (Gestionnaire des connexions mobiles D-Link) 
rapidement).

3. Cliquez sur Apply (Appliquer) pour enregistrer les paramètres et 
terminer.

Remarque : Veuillez réinitialiser ces paramètres lorsque vous voulez installer le lecteur sur un 
autre PC ou le retirer.

Pour consulter la version de l'application, la version du microprogramme et 
la date de publication du microprogramme, sélectionnez Support > About 
D-Link Mobile Connection Manager (Assistance > À propos du gestionnaire 
des connexions mobiles D-Link).
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Section 12 - Résolution des problèmes

1. Pourquoi ne puis-je pas me connecter à un réseau de service mobile ?
Le DWM-152 fonctionne avec une carte SIM enregistrée avec un réseau de service compatible. Pour obtenir des 
informations sur les services auxquels votre carte SIM offre accès, veuillez contactez votre fournisseur de service 
mobile. L'adaptateur ne se connectera pas à un réseau de service, sauf si tous les paramètres applicables ont été 
correctement définis. Vérifiez que tous les paramètres du profil de connexion sont exacts.

2. Pourquoi le logiciel demande-t-il un code PIN ?
Pour des raisons de sécurité, un code PIN est activé sur certaines cartes SIM. Si le code PIN a été utilisé dans un 
périphérique précédent, il reste identique. Si vous n'en avez pas défini, veuillez contacter votre fournisseur de service 
mobile.

3. Pourquoi la vitesse de connexion et le débit de transfert des données sont-ils lents ?
Vérifiez la force du signal du réseau. Un signal faible offre de piètres performances.

4. Pourquoi suis-je incapable de recevoir des SMS ?
Cela peut se produire lorsque la mémoire de la carte SIM est pleine. Vous devrez peut-être supprimer des messages 
pour libérer de l'espace.

5. Pourquoi une seule partie du nom est-elle enregistrée lorsque j'ajoute un nouveau contact ?
La carte SIM peut contenir un maximum de 12 lettres/caractères correspondant à un nom de contact.

6. Pourquoi l'icône de connexion Windows affiche-t-elle une vitesse de 115,2 Kbits/s ?
115,2 Kbits/s correspond au débit de données du périphérique USB, pas à la vitesse de connexion. Veuillez vous 
reporter aux statistiques de connexion indiquées dans le gestionnaire de connexions mobiles pour prendre connaissance 
du débit de connexion.

Résolution des problèmes

Version 1.00     2009/04/29
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Annexe A - Glossaire

Glossaire
2G - Technologie de mise en réseau mobile de deuxième génération. Représente un passage de l'analogique au 
numérique ; la plupart des réseaux 2G utilisent le GSM.

3G - Technologie de mise en réseau mobile de troisième génération permettant un transfert simultané de données 
vocales et non vocales ; la plupart des réseaux 3G utilisent WCDMA.

3.5G - Norme plus récente de technologie de mise en réseau mobile ; utilise généralement HSDPA.

3.75G - Norme plus récente de technologie de mise en réseau mobile ; utilise généralement HSUPA.

APN (Nom/Réseau du point d'accès) - Fournit des informations d'acheminement GPRS. Se compose de : ID du 
réseau : Identifie le service externe demandé par un utilisateur GPRS. ID opérateur du réseau mobile : Indique les 
informations d'acheminement.

ARFCN (Absolute Radio Frequency Channel Number) - ID spécifiques à tous les canaux radio utilisés dans le 
cadre de communications mobiles cellulaires.

Bps (bits par seconde) - Mesure du débit de données. 

DNS (Nom de domaine du système) - Facilite le trafic réseau grâce à un processus d'adressage plus convivial.

DHCP (Protocole de configuration de l'hôte dynamique) - Manière dont les périphériques obtiennent leurs 
adresses IP d'un serveur.

DUN (Réseau téléphonique public commuté) - Composant Windows activant l'accès en ligne par modem.

EDGE (GSM à débit amélioré) - GPRS amélioré permettant de diffuser du contenu multimédia et d'autres données 
de plus grande largeur de bande (jusqu'à 237 kbits/s).

GPRS (Service général de radiocommunication par paquets) - Fournit des données par paquets atteignant 
86 kbits/s.
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GSM (Système mondial de communication avec les mobiles) - Réseau cellulaire le plus utilisé ; fonctionne 
principalement sur 850-900 ou 1 800-1 900 MHz ; principal système de 2G.

IMEI (Identité internationale d'équipement mobile) - Nombre propre à chaque périphérique GSM/UMTS pouvant 
servir à bloquer l'accès au réseau en cas de vol d'un périphérique mobile.

IP (Protocole Internet) - Achemine des paquets sur un réseau.

HSDPA (Accès par paquet en liaison descendante haut débit) - WCDMA amélioré fournissant des données très 
consommatrices de largeur de bande (jusqu'à 7,2 Mbits/s) ; généralement associé à 3.5G.

HSDPA (Accès par paquet en liaison montante haut débit) - WCDMA amélioré fournissant des données très 
consommatrices de largeur de bande (jusqu'à 5,76 Mbits/s) ; généralement associé à 3.75G.

Kbps (Kilobits par seconde) - Mesure du débit ; 1 024 bits/seconde.

LAN (Réseau local) - Réseau de données ayant une plage limitée, mais une bonne largeur de bande.

Mbps (Mégabits par seconde) - Mesure du débit ; 1 048 576 bits/seconde.

PPP (Protocole point à point) - Méthode de connexion Internet.

PIN (Numéro d'identification personnelle) - Code de sécurité à huit chiffres sur une carte SIM permettant d'accéder 
à un réseau de communication mobile d'un utilisateur.

PUK (Clé de déblocage personnelle) - Code servant à débloquer un code PIN bloqué. En général, si le mauvais 
code PUK est saisi dix fois dans une ligne, la carte SIM est bloquée définitivement ; une nouvelle carte SIM est 
requise.

Rx (Réception) - Courte bande destinée à la réception.

SIM (Module d'identification de l'abonné) - Petite carte contenant les informations d'identification, de souscription 
et de contact du périphérique mobile à clé.
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SMS - Permet de rédiger des messages de 160 caractères maximum.

Tx (Transmission) - Courte bande destinée à la transmission.

WCDMA (Accès multiple par répartition en code à large bande) - WCDMA est l'une des principales technologies 
de la mise en œuvre de systèmes cellulaires de troisième génération (3G). Ce produit prend en charge WCDMA 
jusqu'à 384 kbits/s.
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Annexe B - Caractéristiques techniques

Caractéristiques techniques
Configuration minimale requise

Windows 2000/XP/Vista ou Mac OS X 10.4.0 ou toute •	
version ultérieure
Pentium 500 MHz ou version supérieure•	
RAM de 128 Mo ou version supérieure•	
50 Mo d'espace disque disponible•	
Internet Explorer v6.0 ou / Firefox v1.5 ou toute version •	
ultérieure

Bande GSM (GSM/GPRS/EDGE)
850, 900, 1800, 1900 MHz•	
Puissance de classe 4 (900 / 1 850 MHz)•	
Puissance de classe 1 (1800 / 1 900 MHz)•	

Bande UMTS/HSDPA *
850/1900/2100 MHz•	
Puissance de classe 3 (+24 dBm)•	

Débits de données **
DL : 3,6 Mbits/s (HSDPA)•	
UL : 384 Kbits/s (UMTS)•	

Antenne
Antenne monopôle interne•	

Prise en charge de l'interface
USB 2.0•	

SMS
À liaison commutée (GSM)•	
À paquets commutés (GPRS)•	

Gestionnaire de SMS
Créez, modifiez, transmettez et envoyez des messages•	
Boîte de réception, boîte d'envoi, brouillons et dossiers •	
de messages envoyés

Répertoire téléphonique
Importez, exportez, ajoutez, modifiez et supprimez des •	
dossiers

Compartiment de la carte USIM
Interface standard à 6 broches de la carte SIM•	

Plug-and-Play
Installation automatique du logiciel/pilote•	

État de connexion
Nom du réseau, force du signal, débit d'envoi/réception•	

Voyant lumineux
Voyant à cinq couleurs fournissant des informations sur •	
l'état du périphérique

Lecteur de carte MicroSD
Prend en charge des cartes MicroSD atteignant 8 Go•	

Certification
CE•	
NCC•	

Dimensions (l x L x H)
89,4 x 26,68 x 12 mm•	

Température de fonctionnement
-10 ° à 55 °C (14 °C à 131 °F)•	

* La bande de fréquence prise en charge dépend de la version locale du matériel.
** Les débits de données sont théoriques. Le débit de transfert des données dépend des capacités du réseau et de la force du signal.


